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= Xac dinh loai thw moi can tao.
Vi du: Thiép moi
= Tao hai van ban sau:
> Van ban chinh — Thiép moi
> Van ban chira dir liéu trdbn — Danh sach khach moi

= Thuwc hién cac buwdc tron hai van ban.
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= Tools > Letters and Mailings > Mail Merge...

Tools | Table Window Help AdobePDF Acrobat Comments

1 EndMote X2 2 == 120% - E: -
148! spelling and G k7 == T oS
] Spelling and Grammar... = E .| i= i= &= iE | . E
142, Research.. Alt+Click

AR RN S BT ST B AR B -
! Language (= : : :

Word Count...

a AutoSummarize...
Speech

Shared Workspace...

Track Changes Ctrl+Shift+E
Compare and Merge Documents...
Protect Document...

Online Collaboration 3

Letters and Mailings k || Mail Merge...

Macro 3 Show Mail Merge Toolbar

Templates and Add-Ins... =1 Envelopes and Labels...

AutoCorrect Options... Letter Wizanrd..

Custormize...

Options...
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Tron thw

Buodc 1:
Chon loai thu trén.

CuuDuongThanCong.com

=

Select document type

What type of document are you working
on?

@ Letters
1 Envelopes

1 Labels

) Directory

Letters

Send letters to a group of people. You can
personalize the letter that each person
receives,

Click Mext to continue.

Step 1 of 6

& Mext: Starting document

https://fb.com/tailieudientucntt
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s Tron thw

Select starting document

r
= Buorc 2:
w rd How do you want to set up your letters?
C h O n Va n b a n @ Use the current document

(71 Start from a template

() Start from existing document

chtra nOi dung o the corpent il

Start from the document shown here and use the Mail Merge wizard to add redpient information,
thu.

Step 2 of 6

& Mext: Select recipients
4@ Previous: Select document type
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. Tron thw

. Budc 3: o I

Select recipients

@ Use an existing list

C h c_) n Vé n b é n () Select from Outlook contacts

(71 Type a new list

chira d¥ liéu tron. e ot e

IIse names and addresses from a file or a database.

[F Browse...

@ Edit redpient list...

Step3of 6

& Mext: Write your letter

4 Previous: Starting document
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= Bwdce 3: Chon van ban chira di¥ liéu trén.

Select Data Source -|
Look in: Bl Desktop IEI @ ~ 4| ﬁ X i E = Tools ~
l Mame
My R : . E’;thcs Ch tap i
y Recen :
Documents .E Public g on tap ":]
1% Computer chtra danh sach
- LF Network
. bk
Desktop ., Final
| Thuyet trinh
” B danh sach du tiec
J 2l Downloads - Shortcut _
My Documents | & o Type: Microsoft Excel Worksheet
- Size: 13,5 KB
| Date modified: 18/11/2008 5:41 CH
ﬂ&.‘h!
My Computer
A
= File name: Mew Source... Open
My MNetwork |E| [ - ] [ = ]
Places Files of type: | all Data Sources IEI [ Cancel ]
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= Bwdce 3: Chon van ban chira di¥ liéu trén.

Select Table
Mame Description  Modified Created Type
Sheet1§ 11/18/2008 5:41:12 PM  11/18/2008 5:41:12FPM TABLE
Sheet2§ 11/18/2008 5:41:12 PM  11/18/2008 5:41:12PM TABLE
Sheet3s 11/18/2008 5:41:12PM  11/18/2008 5:41:12PM TABLE
4| 1l | b
First row of data contains column headers [ Ok ] | Cancel ),
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Buwd&c 3: Chon van ban chira dir liéu tron.

"

Mail Merge Recipients

To sort the list, dick the appropriate column heading. To narrow down the redpients displayed by a
spedific criteria, such as by dty, dick the arrow next to the column heading. Use the chedk boxes or
buttons to add or remove recipients from the mail merge.

List of recipients:
| Anh Hai

] ChiBa

CoTu

Di Nam

BE Teo

BeTi

Bac Tam

Ba Mudi

Select Al | | Clear Al | | Refresh |
Find... | Edit... | validate | | ok |
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% Tron thw

) . . : Mail Mer v x
= Budc 3: Chon van ban m |
’ ~ = ’N lect recipie
chira di¥ liéu tron. o

(1 Select from Outlook contacts

(1 Type a new list

Use an existing list
Currently, your redpients are selected from:
[Sheet14] in "danh sach du tiec.xls™

E Select a different list. ..

T Edit redpient list...

Step 3 of 6

B Mext: Write yvour letter

4@ Previous: Starting document
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Buwdc 4: Viét thw — chén di¥ liéu vao van ban thuw.
TN = REWE TNV A N N A0 R = K ST - He

—

+ B

Ell_-g-l-l-ll-z-ll-3-l-l4-|-5l-|-

Than moi ...

Dén du bira tiéc chung vui cing
gia dinh chung to1 tai nha hang
Hon Ngoc Phuong Nam, vao luc
18h ngay 20 thang 11 nam 2000.
S hién dién cua ... 1a niém vinh
hanh cho gia dinh ching t6i.

= elEl=zm « i

CuuDuongThanCong.com

m

i 44 TimesNewRoman - 12 «|B I [E|SE E=lz-|i= = == (0- %~ A-

-
]
@
¥

Write your letter

v X

If you have not already done so, write your

letter now,

To add redpient information to your letter,
dick a location in the document, and then

dick one of the items below.
|5} Address block. ..
|2 Greeting line...
.ifJ Electronic postage. ..
E More items...

When you have finished writing your letter,

click Mext. Then you can preview and
personalize each recipient's letter.

Step 4 of 6

& MNext: Preview your letters

@ Previous: Select recipients

https://fb.com/tailieudientucntt
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Than moi [ARBREEY dén di bira
tiec chung vui cung gia dinh chung
161 tai nha hang Hon Ngoc Phurong
Nam. vao luc 18h ngay 20 thang

11 nam 2000.

Str hién dién cua (ARRNEED 13
niém vinh hanh cho gia dinh ching
1oi.

@Bz 6 « m

CuuDuongThanCong.com

w. Tron thw <

Budc 4: Viét thw — chén d
D[ R ERRE R RN T ENRE SART D

~

W

m

-

HOD e

: bail Merge

liéu vao van ban thuw.

=

v X

Write your letter

If you have not already done so, write your
letter mow.

To add recipient information to your letter,
dick a location in the document, and then
dick one of the items below.

5] Address block...

=] Greeting line...

;_?] Electranic postage. ..
E More items...

When you have finished writing your letter,
dlick Mext. Then you can preview and
personalize each recipient's letter,

Step 4 of 6

5 Mext: Preview your letters

4@ Previous: Select redpients

https://fb.com/tailieudientucntt
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» Buwdc 5: Xem trwde két qua tron thu.

Ell-é-l-]_-l-z-|-3-|-4-|-5-|-ﬁ.-|

—1

&

Than moi DINGE dén dy bira tide
chung vui cung gia dinh chung téi
tai nha hang Hon Ngoc Phuong
Nam. vao luc 18h ngay 20 thang
11 nam 2000.

Str hién dién ciia DINGM 13 niém
vinh hanh cho gia dinh ching t61.

B|E|= 6 « m

CuuDuongThanCong.com

m

H D

: Mail Merge v

Preview your letters

One of the merged letters is previewed here,
To preview another letter, dick one of the
following:

Redpient: 3
% Find a redipient...
Make changes

You can also change your redpient list:
= Edit redpient list...

[ Exclude this recipient

When you have finished previewing your
letters, dick Mext. Then you can print the
merged letters or edit individual letters to
add personal comments.

StepS5of 6

% Mext: Complete the merge
@ Previous: Write your letter
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» Buwdc 6: In két qua ra may in hay tap tin.

Ell-é-l-]_-ll-z-|I-3-|-I4-|-5I-|-6-I|TI§hhi|MEI - wr
. Thén moi DINGH dén di bita tige

~ chung vui cung gia dinh chung toi Complete the merge

: tai nha hﬂﬂg Hon NEDC thg = Mail Merge is ready to produce your letters,

- Nam, vao luc 18h ngay 20 thang To personalize your letters, dick "Edit

) - Individual Letters.” This will open a new

_ 11 nam 2000. document with your merged letters. To make

; S hién dién cia - 1a ﬂléﬂfl —  changes to all the letters, switch badk to the

" ; ¥ * ) . ; \: original document.

: vinh hanh cho gia dinh cling t6i.

- Merge

i Lty Print...,

N m Edit individual letters. ..

- Merge to new document
" "

; @ Step 6 of 6

N ¥ “@ Previous: Preview your letters
=mlE|l=m « m b
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3-|-2-|-1-|-é-|-1-|-1-|-3-|-4-|-5-|-e-|-?-|-3-|-9-|-m-|-11-|-1z-|-13-|-§-|-15-|-15-|-1?-|-

Than moi [GHBE dén du bita tiéc chung vui cling gia dinh chiing t6i tai nha hang
Hon Ngoc Phirong Nam, vao luc 18h ngay 20 thang 11 nam 2000.
Str hién dién cua (GHBA 13 niém vinh hanh cho gia dinh ching t4i.

Than moi G088 dén dw bita tiée chung vui cing gia dinh chiing tai tai nha hang
Hon Ngoc Phirong Nam, vao luc 18h ngay 20 thang 11 nam 2000.
Str hién dién cia BB 14 niém vinh hanh cho gia dinh ching toi.

Than moi DINGE dén du bira tide chung vui ciing gia dinh ching t6i tai nha hang
Hon Ngoc Phirong Nam, vao lic 18h ngay 20 thang 11 nam 2000.
Str hién dién cia [DINGM 13 niém vinh hanh cho gia dinh chiing toi.

Than moi BEMEE dén dy bita tiéc chung vui ciing gia dinh ching t6i tai nha hang
Hon Ngoc Phirong Nam, vao luc 18h ngay 20 thang 11 nam 2000.
Str hién dién cia BEIIEY 14 nidém vinh hanh cho gia dinh ching ti.

Than moi BEMN dén du bifa tiéc chung vui ciing gia dinh ching tdi tai nha hang
Hon Ngoc Phirong Nam, vao luc 18h ngay 20 thang 11 nam 2000.
Str hién dién cia B8N 14 niém vinh hanh cho gia dinh ching toi.

Than moi BEGHaM dén dy bira tiée chung vui cling gia dinh ching t0i tai nha
hang Hon Ngoc Phwong Nam, vao Iic 18h ngay 20 thang 11 nim 2000.
Sir hien dién cua 1a niém vinh hanh cho gia dinh chung t6i.

Than moi BEIVIMGI dén dir bita tiéc chung vui cing gia dinh ching toi tai nha
hang Hon Ngoc Phwong Nam, vao Iic 18h ngay 20 thang 11 nim 2000.
Str hién dién cia BEIMIMGN 13 niém vinh hanh cho gia dinh chiing toi.
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€ Mau dinh dang S —

>

= Xem style: Format > Styles and Formatting

EU-we-ln-z-ll-l-I'I4'I'5I'"ETIEStyI.Eandmeatting v X
- ®|®|a '
|:| Formatting of selected text

1.1 Heading 2

1z

- 1.2 Muk tiéu, giéi han va

Dat con tro
chubt tai doan
muodn xem style

[5E|ECt|I5J| ] [New Style... ]

1.2.1 Muc tieu luan van Pick formatting to apply

b

Muc tiéu cia ludn véan la o Chwong 1. Headingl v

N .. ) . Chwong 1. Heading 1 +1]
< @0, tap trung nghién ciru cac va
1.1 Heading 2 1

1.1.1 Heading 3 0l

phép mé rong khai niém, céc c3

- phap rat trich [ g0 013 doan
trich khai nién| dang co con tro

chudt

1.1.1 Heading 3+ 10 pt

1.1.1 Heading 3 + 13 pt

1.1.1 Heading 3 + First

Ngoai ra, muc tiéu cua luE;

thana tin v hnae Adiea trdn 17 Show: |Formatting in use IEI

= 2 [t 3

g
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» Ap dung style

» Thanh cong cu dinh dang: == Ligt;ﬂal s Bﬂf
— Chon doan van ban e Lict Eullet ,]‘
— Chon Style trong danh sach hoac o ListBullet 2 11‘
trong bang diéu khién Style and o List Bullet 3 1
Formatting e List Bullet4 11‘

o ListBullet 5 1
List Continue 11‘
List Cantinue 2 11‘
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% Mau dinh dang =

Pién cac

= Tao style moi

théng tin vé

Style

maoi

! Styles and Formatting Mew Style \/ (3w
(- i Properties
Formatting of selected text Nhan nut Mame: |M |
N 1 / NeW Style Style type: |Paragraph |Z|
1/4 Style based on; | 1l Heading 2 |Z|
[ Seleci Al ] [ pemShic Style for following paragraph: | 1 Style4 |Z|
Pick formatting to apply Formatting
Clear T ing - |ﬂmesNewF‘.nman | E: I |g |év
: === -B=|izi|= =
Heading 1 v B -B=12=:
Heading 2 1 11 Muc tién, gidi hen va dong 20p cia luin vin
Heading 3 1
Normal 1
Heading 2 +
[ add to template [7] automatically update
o) e

CuuDuongThanCong.com
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Formatting of selected text

1.1.1 Heading 3

| selectAll | | New Style... |

Pick formatting to apply

Chwong 1. Heading 1
1.1 Heading 2

+] 4

1

1.1.1 Heading 3

1.1.1 H Select All 44 Instance(s) |:|
Meodify...
1.1.1 <
Delete...
1. Update to Match Selection

1.1.1.1 Heading 4

'3

Chon style
muon sra

Nhan phai
chubt, chon
~~_ Modify...

Show: | Formatting in use

CuuDuongThanCong.com
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€ Mau dinh dang

Modify Style
N ) I
= Hiéu chinh style o= |
Style type: Paragraph and character
Style based on: 11 Mormal |E| I
Style for following paragraph: 1l Heading 3 |Z|
Formattng
Times Mew Roman |E| 14 |E| | I u | é -

Ak
"l
¥

B -8=t

¥
+

Nhan nut 111 Mo G edvia
Format

Mormal + Font: 14 pt, Bold, Indent: Left: 0 cm, Hanging: 1,27 cm,
Justified, Line spacing: 1.5 lines, Space Before: 13 pt, After: 12 pt,
Lewvel 3, Outline numbered + Level: 3 + Mumbering Style: 1, 2, 3, ... +
Start at: 1 + Alignment: Left + Aligned a...

[ add to template [] Automatically update L
Format ~ | ok || canel |
=
| Font... I
Baragraph...
Tabs...

Chon théng tin | | Border.. :

mudn stra | Lengusge.. _

Frame...

Murnbering...

Shortcut key...
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g Tao bang muc luc s
—

= Buoc 1:
'Dlnh dang CéC d‘é Index and Tahles ['5__<|

Index | Table of Contents : | Table of Figures | Table of Autharities

m U C Vé n bé n bé n g Frint Preyiew Wb Preview

Headjn,g.ll A | Heads .1 -
Style. e R— ] )
» Buwdce 2: Dat con tro

" ] V4 AN > ‘| H .
ta I VI trl Ch e n b a n g Show page numbers Use hypetlinks instead of page numbers

Right align page numbers

muyc Iyc. a3
Insert > Reference |~ =™ ™ -[ R
> [ndex and Tables o [cancel
> Table of Contents

ongThanCong.com https://fb.com/tailieudientucntt


http://cuuduongthancong.com?src=pdf
https://fb.com/tailieudientucntt

% Tao bang muc luc

/

« S dung Style dé mé rong TOC

» Nut Options...
» Thém bét cac dé muc.

CuuDuongThanCong.com

Table of Contents Options

Build table of contents From:

Available skyles:
~ Heading 1
» Heading 2
v Heading 3

Heading 4
Heading &

Heading &

Ckling levels
[ ] Table entry Fields

%]
TOC |evel:
1 N
. E.
3
b
QK | | Cancel
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